
Chapter 8

Defi ning Materials 
and Boundary 

Conditions 

  Learning Objectives 
After completing this chapter, you will be able to:
• Defi ne materials and boundary conditions in FEA models
• Assign material to FEA Models
• Manage material libraries in Autodesk Simulation Mechanical
• Apply boundary conditions
• Understand different types of constraints
• Apply constraints to an FEA model
• Understand different types of loads
• Defi ne loading conditions for an FEA Model
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INTRODUCTION
Defi ning material and boundary conditions of an FEA model is one of the most important 
steps in an analysis process. In Autodesk Simulation Mechanical, you are provided with 
Autodesk Simulation Material Library and  Autodesk Simulation Plastics Library that contain 
almost all the standard materials. You can select the required material from these libraries 
and assign it to the selected part of the model. You can also edit some of the properties of 
the standard materials available in the libraries such as mass density, modulus of elasticity, 
poisson’s ratio, thermal coeffi cient of expansion, and shear modulus of elasticity as per the 
project requirement. Additionally, in Autodesk Simulation Mechanical, you can also create a 
new library with user-defi ned materials. 

 ASSIGNING MATERIAL
As discussed earlier, material properties must be assigned for each part in the model on which  
the analysis process is to be carried out. When you assign a material to a part, all physical 
properties of the selected material will be assigned to the part. To assign a material to a part 
of the model, right-click on the Material <Unnamed> option available under the Part node 
in the Tree View and then select the Edit Material option from the shortcut menu displayed, 
refer to Figure 8-1; the Element Material Selection dialog box will be displayed, as shown 
in Figure 8-2. 

Figure 8-1  Selecting the Edit Material option 

Note
The Edit Material option is enabled in the shortcut menu only when the part is meshed. 
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Figure 8-2  The Element Material Selection dialog box

By default, Autodesk Simulation Material Library is selected in the Select Library drop-down 
list of the Element Material Selection dialog box. As a result, a number of material families   
that are available in this library are listed in the left area of the dialog box. Click on the +sign 
located on the left of the desired material family to display all materials under that family. 
Figure 8-3 shows the Element Material Selection dialog box with the Aluminum material 
family expanded. Select the required material from the expanded material family from the 
left area of the dialog box; all the properties of the selected material will be displayed on the 
right of the dialog box. Next, choose the OK button; the material properties of the selected 
material will be assigned to the selected part.

In Autodesk Simulation Mechanical, you can also change or modify the material properties 
of the selected material. To do so, select the required material from the left of the Element 
Material Selection dialog box. Next, choose the Edit Properties button available on the 
bottom of the dialog box; the Element Material Specifi cation dialog box will be displayed, 
refer to Figure 8-4. In this dialog box, you can specify new mass density, modulus of elasticity, 
poisson’s ratio, and thermal coeffi cient of expansion for the selected material. After specifying 
the new material properties for the selected material in the dialog box, choose the OK button; 
the material properties of the selected material will be modifi ed accordingly. 
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Figure 8-3  The expanded Aluminum category in the Element Material Selection dialog box

Figure 8-4  The Element Material Specifi cation dialog box
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Note
The changes made in the material properties of the selected material by using the Element 
Material Specifi cation dialog box will be saved in the model database only. In other words, 
there will be no modifi cation made in the material library of Autodesk Simulation Mechanical. 
As a result, when you invoke the same material next time, its default or standard properties will 
be displayed.

 MANAGING MATERIAL LIBRARIES
Autodesk Simulation Mechanical allows you to manage material libraries by creating new 
material libraries, material categories, user-defi ned materials, setting selected library as default 
library, and so on. The procedure to perform all these operations for managing material 
libraries is discussed next.   

 Creating  New Material Library
By default, in Autodesk Simulation Mechanical, you are provided with Autodesk Simulation 
Material Library and Autodesk Simulation Plastics Library. In addition to the default material 
libraries in Autodesk Simulation Mechanical, you can also create new material libraries. To do 
so, click on the Tools tab in the Ribbon to display all the tools available in this tab. Next, choose 
the Manage Material Library tool from the Options panel of the Tools tab; the Autodesk 
Material Library Manager dialog box will be displayed, as shown in Figure 8-5. 

Figure 8-5  The Autodesk Material Library Manager dialog box
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Choose the New button from the dialog box; the Create Material Library dialog box will be 
displayed. Browse to the location where you want to save the material library fi le and then 
specify a name to it in the File name edit box of the dialog box. Next, choose the Save button; 
the Create Library window will be displayed, refer to Figure 8-6. By default, the name entered 
for the previously created material library fi le will be displayed in the edit box of the Create 
Library window. You can enter a unique name for the material library in this edit box. Note 
that the material library created will be displayed in the list of available material libraries with 
the specifi ed name. Enter the name for the material library and then choose the OK button; a 
new material library of the specifi ed name will be created and selected in the Library Selection 
drop-down list of the Autodesk Material Library Manager dialog box. Figure 8-7 shows the 
Autodesk Material Library Manager dialog box with the new material library created.  

Figure 8-6  The Create Library window

Figure 8-7  The new material library created and selected in the Autodesk Material 
Library Manager dialog box
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 Adding Material Categories
In a library, you can group materials of same family in a category. To create a category inside 
the library, invoke the Autodesk Material Library Manager dialog box by choosing the Manage 
Material Library tool from the Options panel of the Tools tab. Next, select the required 
library from the left of the Autodesk Material Library Manager dialog box and right-click; 
a shortcut menu will be displayed, refer to Figure 8-8.    

Figure 8-8  A shortcut menu displayed in the Autodesk Material Library Manager 
dialog box

Select the Add New Material Category option from the shortcut menu displayed; the 
Material Category Name window will be displayed, as shown in Figure 8-9. Enter the name 
of the category in the edit box of the window and then choose the OK button; the category 
of the specifi ed name is created. Similarly, you can create multiple categories in the library. 
Figure 8-10 shows the Autodesk Material Library Manager dialog box with categories named 
AB, GA, and KV created under the CADCIM Material Library library.
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Figure 8-9  The Material Category Name window

Figure 8-10  The Autodesk Material Library Manager dialog box with categories named 
AB, GA, and KV created under the CADCIM Material Library

 Adding Material Under a Material Category
To add material under a category of a library, invoke the Autodesk Material Library Manager 
dialog box and then select the category for which you want to add the material. Next, right-click 
and select the Add New Material option from the shortcut menu displayed; the New Material 
dialog box will be displayed, refer to Figure 8-11.

Specify the name of the material, type of material, material description, material source 
description (if any), and material source URL in their respective fi elds available on the left 
of the New Material dialog box. After specifying all the details, choose the OK button; the 
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material with the specifi ed details will be created and listed under the selected category in the 
Autodesk Material Library Manager dialog box, refer to Figure 8-12. 

Figure 8-11  The New Material dialog box

Figure 8-12  The new material AB-10011 is added under the AB category of the library
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Now you need to specify the material properties for the newly created material. To do so, 
select the newly created material from the left of the Autodesk Material Library Manager 
dialog box; all the default material properties of the selected material will be displayed on the 
right of the dialog box. Specify the mass density, modulus of elasticity, poisson’s ratio, shear 
modulus of elasticity, thermal conductivity, and so on of the material in their respective fi elds 
available on the right of the dialog box. After specifying all the material properties for the 
added material, choose the Save Changes button available at the top of the dialog box; the 
specifi ed material properties will be saved in the material library fi le. Similarly, you can add 
a number of materials with user-defi ned material properties as per the requirement.  

 Deleting Material
In Autodesk Simulation Mechanical, you can delete a material from a material library. To do so, 
invoke the Autodesk Material Library Manager dialog box and then select the material library 
from the Library Selection drop-down list of the dialog box whose material is to be deleted. 
Next, select the material to be deleted from the material library list and right-click to display 
a shortcut menu. Choose the Delete Material option from the shortcut menu displayed; the 
Delete Material window will be displayed asking you to confi rm whether you want to delete 
the selected material and its properties or not. Choose the Yes button from the window; the 
selected material will be deleted from the list of materials available in the library.  

 Deleting Material Category
Similar to deleting material from the library, you can also delete a material category from a 
material library. To do so, invoke the Autodesk Material Library Manager dialog box and 
then select the material library from the Library Selection drop-down list of the dialog box 
whose material category is to be deleted. Next, select the material category to be deleted from 
the material library list and right-click to display a shortcut menu. Choose the Delete Material 
Category option from the shortcut menu; the Delete Category and Materials window will be 
displayed asking you to confi rm whether you want to delete the selected category and all its 
materials or not. Choose the Yes button from the window; the selected material category and 
all the materials available under it will be deleted from the library. 

 Loading Material Library File
In Autodesk Simulation Mechanical, the material library fi le is saved in .mlb format. The .mlb 
is the fi le extension for material library fi les. If you have a material library fi le (.mlb) which is 
currently not loaded in Autodesk Simulation Mechanical, you can load it by using the Add 
button available in the Autodesk Material Library Manager dialog box. To load a material 
library fi le, invoke the Autodesk Material Library Manager dialog box and choose the Add 
button from it; the Add Library to Available Library List dialog box will be displayed. 
Browse to the location where the library fi le (.mlb) is saved. Next, select the library fi le to be 
loaded and then choose the Open button from the dialog box; the Add Library dialog box 
will be displayed. Choose the OK button from the dialog box; the selected material fi le will 
be uploaded and a list of all the materials available in library fi le will be displayed in the left 
of the dialog box.
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 Setting Material Library as Default Library
By default, the Autodesk Simulation Material Library library is set as the default library. As a 
result, whenever you invoke the Element Material Selection dialog box to assign material to a 
model, the Autodesk Simulation Material Library is selected in the Select Library drop-down 
list and displays all the available material categories on the left in the dialog box. You can also 
set any other material library as the default library as per the requirement. To do so, invoke the 
Autodesk Material Library Manager dialog box by choosing the Manage Material Library 
tool from the Options panel of the Tools tab in the Ribbon. Next, select the material library 
that you want to set as the default library from the Library Selection drop-down list of the 
dialog box. Click on the down arrow available on the right of the selected library title in the 
dialog box to display a menu, refer to Figure 8-13. Select the Set as Default option from the 
menu displayed; the selected library will be set as the default library. 

Figure 8-13  Partial view of the Autodesk Material Library Manager dialog box 
with a menu displayed by clicking on the down arrow

 Removing/Deleting Library
In Autodesk Simulation Mechanical, you can remove material libraries from the list of libraries 
that are no longer required. To do so, invoke the Autodesk Material Library Manager dialog 
box and then select the material library that you want to remove from the list of libraries. Next, 
click on the down arrow available on the right of the selected library title in the dialog box 
to display a menu, refer to Figure 8-13. Choose the Remove Library option from the menu 
displayed; the Database Removal window will be displayed asking you whether you want to 
remove the library or not, refer to Figure 8-14. 

Figure 8-14  The Database Removal window
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Choose the Yes button from the Database Removal window; the selected library will be removed. 
However, its data fi les will still be available in your system hard disk. As a result, you can load 
the removal material library again by loading its data fi les as discussed earlier in the section 
Loading Material Library File.   

To permanently remove the library, select the Delete Library option from the menu displayed 
instead of selecting the Remove Library option. On selecting this option, the Database 
Deletion window will be displayed asking you whether you want to remove the library and its 
database fi les from the disk or not, refer to Figure 8-15. Choose the Yes button, the selected 
library will be removed from the list of libraries. Also, its data fi les will be deleted from the 
system hard disk. 

Figure 8-15  The Database Deletion window

 Copying Material Library
In Autodesk Simulation Mechanical, you can create a copy of a material library to create a 
new material library by editing the material properties of the materials available in the copied 
library. To create a copy of an existing library, invoke the Autodesk Material Library Manager 
dialog box and then select the material library to be copied from the Library Selection 
drop-down list. Next, click on the down arrow available on the right of the selected library 
title in the dialog box to display a menu, refer to Figure 8-16. Select the Copy Library option 
from the menu displayed; the Copy Library To dialog box will be displayed. Browse to the 
location where you want to copy the library fi le and then specify a name for the new library 
fi le in the File name edit box of the dialog box. Next, choose the Save button; the Create 
Library window will be displayed. By default, the name entered previously copied for the 
material library fi le will be displayed in the edit box of this window. You can specify a unique 
name for the new material library in this edit box. Note that the material library created will 
be displayed in the list of available material libraries with the name entered in this edit box. 
Enter the name for the material library and then choose the OK button; a new material library 
with the specifi ed name will be created and selected in the Library Selection drop-down list 
of the Autodesk Material Library Manager dialog box. Note that in the material library 
created, all the materials and their material properties are same as that of the parent material 
library. You can change the material properties as discussed earlier and then choose the Save 
Change button.
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Figure 8-16  A menu displayed in the Autodesk Material Library Manager dialog box

 BOUNDARY CONDITIONS
Boundary conditions are defi ned on the boundary of an FEA model to represent the effect 
of the surrounding environment. It includes forces, pressures, displacement, and so on. In 
Autodesk Simulation Mechanical, the boundary conditions are divided into two categories: 
loads and constraints. Both are discussed next.

 Constraints
Constraints are defi ned as the boundary conditions that prevent the model from translation 
or rotational movement. In other words, the constraints are used to restrict the degree of 
freedom of a model. The applied constraints act as rigid supports between the model and the 
ground. You can select nodes, edges, and surfaces of a model to apply constraints. The tools 
used for applying constraints are discussed next.  

 General Constraint
  Ribbon: Setup > Constraints > General Constraint   

The General Constraint tool is used to constrain the degree of freedom of nodes. 
You can select nodes, edges, or surfaces of a model to apply constraint by using the 
General Constraint tool. Note that depending upon the geometry selected for 
applying the constraint, the degree of freedom of the nodes of the selected geometry 
will be constrained. The procedure of applying general constraint on nodes, edges, 

and surfaces of the model are discussed next.

 Applying  Nodal General Constraint 
General constraint applied on a node is called nodal general constraint. To apply a nodal 
general constraint, select a node of the model on which you want to apply the constraint 
and then choose the General Constraint tool from the Constraints panel of the Setup tab 
in the Ribbon; the Creating Nodal General Constraint Object dialog box will be displayed, 
as shown in Figure 8-17. Alternatively, you can invoke this dialog box by selecting a node 
and right-clicking in the drawing area to display a shortcut menu. Next, select Add > 
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Nodal General Constraint from the shortcut menu displayed. The options available in 
this dialog box are discussed next. 

Figure 8-17  The Creating Nodal General Constraint Object dialog box

Tip. You can also select multiple nodes of a model to constrain by using the CTRL key. On 
selecting more than one node, the name of the dialog box invoked on choosing the General 
Constraint tool will be changed to Creating (number of nodes selected) Nodal General 
Constraint Objects. 

 Constrained DOFs Area
The Constrained DOFs area of the dialog box is used to control or specify the 
constraints for the selected node. By default, all the check boxes available in this 
area are cleared. As a result, all degrees of freedom of the selected node are free. On 
selecting the Tx check box, the translation degree of freedom along the X-axis of the 
selected node will be constrained. Similarly, on selecting the Ty and Tz check boxes, 
the translation degree of freedom along the Y and Z axes will be constrained.

To constrain the rotational degree of freedom along the X, Y, and Z axes, you can 
select the Rx, Ry, and Rz check boxes, respectively, from the Constrained DOFs area 
of the dialog box.   

Predefi ned Area
The buttons available in the Predefi ned area of the dialog box are used to select 
predefi ned sets of constraints to be applied to the selected nodes. On choosing the 
Fixed button from the Predefi ned area, the degree of freedom of the selected nodes 
will be fi xed and all the check boxes available in the Constrained DOFs area of the 
dialog box will be selected.
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On choosing the Free button from the Predefi ned area, all the selected check boxes of 
the Constrained DOFs area will be cleared and the degree of freedom of the selected 
nodes will be free. If you choose the No Translation button, the translation degree 
of freedom along X, Y, and Z axes of the selected nodes will be constrained and the 
rotational degree of freedom along the X, Y, and Z axes will be free to rotate. On 
selecting the No Rotation button, the rotational degree of freedom of the selected 
nodes along X, Y, and Z axes will be constrained and the translation degree of freedom 
along X, Y, and Z axes will be free.

Similarly, you can choose the X Symmetry, Y Symmetry, Z Symmetry, X 
Antisymmetric, Y Antisymmetric, and Z Antisymmetric buttons from the Predefi ned 
area of the dialog box to apply the predefi ned sets of symmetric or antisymmetric 
constraints to the selected nodes.   

Description 
The Description area of the dialog box is used to enter a comment or description 
about the constraint being applied.

After specifying the required set of constraints to be applied to the selected nodes, choose the 
OK button from the dialog box; the constraint will be applied. Figure 8-18 shows a meshed 
model with fi xed constraint applied on some of the nodes. 

Figure 8-18  The fi xed constraint applied to some of the nodes of the model

Applying  Surface Constraint 
General constraint applied on a surface is called surface general constraint. To apply 
surface general constraint, select the surface of the model on which you want to apply 
constraint and then choose the General Constraint tool from the Constraints panel of 
the Setup tab in the Ribbon; the Creating Surface General Constraint Object dialog box 
will be displayed, as shown in Figure 8-19. Alternatively, you can invoke this dialog box 
by selecting a surface and right-clicking in the drawing area to display a shortcut menu. 
Next, select Add > Surface General Constraint from the shortcut menu displayed. The 
options available in this dialog box are same as discussed earlier. Figure 8-20 shows a 
meshed model with the fi xed constraint applied on a surface. 
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Figure 8-19  The Creating Surface General Constraint Object dialog box

Applying  Edge Constraint 
The method of applying constraints on edges is similar to applying constraints on 
surfaces and nodes. Figure 8-21 shows a meshed model with fi xed constraint applied on 
an edge. 

Figure 8-20  The fi xed constraint applied on 
a surface of the model

Figure 8-21  The fi xed constraint applied on 
an edge of the model

Note
To select a node/surface/edge of a model, click on the Selection tab in the Ribbon. Next, choose 
the Point or Rectangle tool from the Shape panel and the Vertices/Surfaces/Edges tool from 
the Select panel of the Selection tab in the Ribbon.

Tip. You can select nodes, surfaces, or edges for applying constraint either before or after 
invoking the dialog box. 
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 Pin Constraint
  Ribbon: Setup > Constraints > Pin Constraint 

The Pin Constraint tool is used to constrain the radial, tangential, and axial 
degrees of freedom of the selected cylindrical surface. This constraint is widely 
used to simulate pin connection. You can apply pin constraint only to a cylindrical 
surface. To apply the pin constraint, select a cylindrical surface of the model on 
which you want to apply the pin constraint and then choose the Pin Constraint 

tool from the Constraints panel of the Setup tab in the Ribbon; the Creating Pin Constraint 
Object dialog box will be displayed, as shown in Figure 8-22. Alternatively, you can invoke 
this dialog box by selecting a cylindrical surface and right-clicking in the drawing area to 
display a shortcut menu. Next, select Add > Surface Pin Constraint from the shortcut menu 
displayed. The options available in this dialog box are discussed next. 

Figure 8-22  The Creating Pin Constraint Object dialog box

Constraints Area
The check boxes available in this area are used to constrain the radial, tangential, and 
axial degrees of freedom of the selected surface. These check boxes are discussed next.    

 Fix Radial
On selecting the Fix Radial check box, the selected cylindrical surface will be restricted 
to move or deform radially. 

 Fix Tangential
On selecting the Fix Tangential check box, the selected cylindrical surface will be 
restricted to rotate tangentially around the circumference of the cylindrical surface 
selected for applying the constraint. 

 Fix Axial 
On selecting the Fix Axial check box, the selected cylindrical surface will be restricted 
to move axially along the axis of the cylindrical surface selected for applying the 
constraint. 
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Description Area
The Description area of the dialog box is used to enter a comment or description about 
the applied constraint.

After fi xing the required degree of freedom of the selected cylindrical surface to simulate the 
pin connection, choose the OK button from the dialog box; the pin constraint will be applied. 
Figure 8-23 shows a model with the pin constraint applied.  

Figure 8-23  The pin constraint applied to the cylindrical surface

 1D Spring Support
  Ribbon: Setup > Constraints > 1D Spring Support  

The 1D Spring Support tool is used to apply stiffness to nodes, edges, or 
surfaces of a model to resist their translational or rotational degree of freedom 
along or about any specifi ed direction vector. Note that the deformation 

that occurs after applying the 1D spring support constraint to a node, edge, or a surface is 
calculated based on the spring equation F = KX. The greater the stiffness value, the lower 
will be the deformation. The procedure of applying 1D spring support constraint on nodes, 
edges, and surfaces of a model are discussed next.

Applying  Nodal 1D Spring Support 
The 1D Spring support applied on a node is called nodal 1D Spring support. To apply 
nodal 1D Spring support, select a node of the model and then choose the 1D Spring 
Support tool from the Constraints panel of the Setup tab in the Ribbon; the Creating 
Nodal 1D Spring Support Element dialog box will be displayed, as shown in Figure 8-24. 
Alternatively, you can invoke this dialog box by selecting a node and right-clicking in the 
drawing area to display a shortcut menu. Next, select Add > Nodal 1D Spring Support 
from the shortcut menu displayed. You can also select multiple nodes by pressing the 
CTRL key. The options available in the Creating Nodal 1D Spring Support Element 
dialog box are discussed next.  
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Figure 8-24  The Creating Nodal 1D Spring Support Element dialog box

Type Area
On selecting the Translation radio button in the Type area of the dialog box, you 
can restrict the translation movement of the selected node or nodes. To restrict 
the rotational movement of the selected node or nodes, select the Rotation radio 
button.   

Direction Area
The Direction area of the dialog box allows you to select the required direction vector 
along/about which you want to restrict the translational/rotational movement. You can 
select the X, Y, or Z radio button to restrict the translational/rotational movement 
along/about X, Y, or Z axis. You can also select the Custom radio button to specify the 
direction vector other than the X, Y, and Z axes directions of the coordinate system. 

To specify the direction vector other than X, Y, and Z directions, select the Custom 
radio button; the X, Y, and Z edit boxes of the dialog box will be enabled. In these 
edit boxes, you can specify the X, Y, and Z coordinates of the direction vector. 

Moreover, you can specify the direction vector by selecting two points. To do so, 
choose the Vector Selector button available on the right of the Custom radio button 
in the dialog box; the dialog box will disappear and you will be prompted to specify 
the direction vector. Specify the start point and then the endpoint toward which the 
direction will point. As soon as you specify the endpoint for the direction vector, the 
Creating Nodal 1D Spring Support Element dialog box will be displayed again with 
the coordinate value of the specifying direction vector displayed in the X, Y, and Z 
edit boxes of the dialog box.
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Stiffness Area
The Stiffness edit box is used to specify the stiffness of the elements for resisting the 
movement in the specifi ed direction.

Description Area
The Description area of the dialog box is used to enter a comment or description 
about the applied constraint.

After specifying all the parameters to defi ne 1D Spring support in a particular direction, 
choose the OK button from the dialog box; the 1D Spring support will be applied.  

Applying  Surface 1D Spring Support 
The 1D Spring support applied on a surface is called surface 1D Spring support. To apply 
Surface 1D Spring support, select a surface of the model and then choose the 1D Spring 
Support tool from the Constraints panel of the Setup tab in the Ribbon; the Creating 
Surface 1D Spring Support Element dialog box will be displayed, as shown in Figure 8-25. 
Alternatively, you can invoke this dialog box by selecting a surface and right-clicking in the 
drawing area to display a shortcut menu. Next, select Add > Surface 1D Spring Support 
from the shortcut menu. You can also select multiple surfaces by using the CTRL key. 
The options available in the Creating Surface 1D Spring Support Element dialog box 
are same as discussed earlier.  

Figure 8-25  The Creating Surface 1D Spring Support Element dialog box

Applying  Edge 1D Spring Support 
The 1D Spring support applied on an edge is called edge 1D Spring support. To apply 
edge 1D Spring support, select an edge of the model and then choose the 1D Spring 
Support tool; the Creating Edge 1D Spring Support Element dialog box will be displayed. 
Alternatively, you can invoke this dialog box by selecting an edge and right-clicking on the 
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drawing area to display a shortcut menu. Next, select Add > Edge 1D Spring Support 
from the shortcut menu. The options available in this dialog box are same as discussed 
earlier.  

Figure 8-26 shows a model with 1D spring support applied on the bottom front edge of the 
top plate.    

Figure 8-26  The edge 1D spring support applied

 3D Spring Support
  Ribbon: Setup > Constraints > 3D Spring Support   

The 3D Spring Support tool is used to apply stiffness to nodes, edges, or 
surfaces of a model to restrict their translational/rotational degree of freedom 
along/about the X, Y, or Z global direction. You can also restrict the 

translational/rotational degree of freedom along/about more than one (X, Y, and Z) global 
directions by using this tool. Note that the deformation that occurs after applying the 3D 
spring support constraint to a node, edge, or a surface is based on the spring equation F = KX. 
The greater the stiffness value, the lower will be the deformation. 

The procedure of applying 3D spring support constraint on nodes, edges, and surfaces of a 
model is same as discussed for applying 1D spring support. The only difference in 3D spring 
support is that you can restrict the translational or rotational movements in all directions 
globally.

To apply 3D spring support, select a node/edge/surface and then choose the 3D Spring 
Support tool from the Constraints panel of the Setup tab in the Ribbon; the Creating Nodal 
3D Spring Support Element/Creating Edge 3D Spring Support Element/Creating Surface 
3D Spring Support Element dialog box will be displayed. Figure 8-27 shows the Creating 
Edge 3D Spring Support Element dialog box displayed on choosing the 3D Spring Support 
tool after selecting an edge. 
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Figure 8-27  The Creating Edge 3D Spring Support Element dialog box

The options available in this dialog box are same as discussed while applying 1D spring support, 
except the options in the Fixed area. The Fixed area and its options are discussed next.

Fixed Area
The Fixed area of the dialog box is used to select the required directions to be resisted 
for translational or rotational movements along or about the X, Y, and Z direction. Select 
the required check boxes from the Fixed area of the dialog box along or about which you 
want to restrict the translational or rotational movements. 

Figure 8-28 shows a model with 3D spring support applied on the bottom front edge of the 
top plate.   

Figure 8-28  The 3D spring support applied
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 Prescribed Displacement Constraint
 Ribbon: Setup > Constraints > Prescribed Displacement 

A prescribed displacement allows nodes to translate or rotate through 
a specifi ed distance in a specifi ed vector direction. You can select nodes, 
edges, or surfaces of a model to apply prescribed displacement by using 

the Prescribed Displacement tool. Note that on selecting an edge or a surface, the prescribed 
displacement will be applied to all the nodes of the selected edge or surface. 

To apply prescribed displacement to a surface, select the surface of a model and then choose 
the Prescribed Displacement tool from the Constraints panel of the Setup tab in the Ribbon; 
the Creating Surface Prescribed Displacement Element dialog box will be displayed, refer 
to Figure 8-29. The options available in this dialog box are discussed next.

Figure 8-29  The Creating Surface Prescribed Displacement Element dialog box

Note
The name of the dialog box displayed on choosing the Prescribed Displacement tool depends 
upon the geometry selected. If you select a node and choose the Prescribed Displacement tool, 
the Creating Nodal Prescribed Displacement Element dialog box will be displayed and if 
you select an edge, the Creating Edge Prescribed Displacement Element dialog box will be 
displayed. However, the options available in the dialog boxes are same.

Type Area
The Translation radio button of the Type area in the dialog box is used to allow the 
translation movement upto the specifi ed magnitude in a specifi ed direction. To allow the 
rotational movement of the selected geometry upto the specifi ed magnitude about an 
axis, select the Rotation radio button from the Type area of the dialog box. 
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Note
The rotational movement can only be possible for the elements that have rotational degrees of 
freedom such as shell and beam elements.  

Magnitude Area
The Magnitude area of the dialog box is used to specify the magnitude for the translation 
or rotational movements.

Direction Area
The Direction area of the dialog box is used to select the required direction vector along 
or about which you want to allow the translational or rotational movements. You can select 
the X, Y, or Z radio button to allow the translational or rotational movement along or 
about X, Y, or Z axis. You can also specify the direction vector other than along the X, 
Y, and Z axes by using the Custom radio button and the Vector Selector button of the 
dialog box, as discussed earlier. 

Stiffness Area
The Stiffness edit box is used to specify the stiffness of the elements to allow the movement 
in the specifi ed direction. Note that the translational or rotational movement of the nodes 
of the model will also depend upon the stiffness value specifi ed in this edit box. The higher 
the stiffness value specifi ed, the greater will be the displacement. 

Description Area
The Description area of the dialog box is used to enter a comment or description about 
the applied prescribed displacement.

Similarly, you can select nodes or edges to apply prescribed displacement. Figure 8-30 shows 
a model with prescribed displacement applied on the curved surface.  

Figure 8-30  The prescribed displacement applied on the curved surface
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 Frictionless Constraint
 Ribbon: Setup > Constraints > Frictionless   

The frictionless constraint is used to restrict the deformation of the selected 
surface along its normal direction due to the force applied on the model. You 
can select planar and cylindrical surfaces of a model to apply frictionless constraint 

by using the Frictionless tool.

To apply frictionless constraint to a surface of the model, select a surface and then choose the 
Frictionless tool from the expanded Constraints panel of the Setup tab in the Ribbon; the 
Creating Frictionless Constraint Object dialog box will be displayed, refer to Figure 8-31. In 
this dialog box, you can enter a comment or description about the frictionless constraint being 
applied in the Description edit box. Next, choose the OK button; the frictionless constraint 
will be applied to the selected surface.

Figure 8-31  The Creating Frictionless Constraint Object dialog box

Figure 8-32 shows a model with frictionless constraint applied to the bottom planar surface 
of a structure member in FEA editor environment and Figure 8-33 shows the model in the 
Result environment of Autodesk Simulation Mechanical after performing the analysis. Note 
that the frictionless constraint does not allow the selected surface to deform along its normal 
direction, refer to Figure 8-33.

Figure 8-32  The frictionless constraint applied to the bottom planar surface of a 
structure member
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Figure 8-33  The model with displacement along the parallel direction after applying 
the frictionless constraint 

Note
You will learn more about Result environment of Autodesk Simulation Mechanical in later 
chapters. 

 Loads
Load is defi ned as the external force acting on the body. It includes forces, pressures, movement, 
and so on. The tools that are used for applying different loading conditions are discussed 
next. 

 Force
  Ribbon: Setup > Loads > Force  

A force is an infl uence that causes an object to undergo a certain change, either 
concerning its movement, direction, or geometrical construction. In Autodesk 
Simulation Mechanical, you can apply force to a node, edge, and surface. 

Applying  Nodal Force 
The force which is applied on a node is called as nodal force. To apply nodal force, select 
the node of the model on which you want to apply the force and then choose the Force 
tool from the Loads panel of the Setup tab in the Ribbon; the Creating Nodal Force 
Object dialog box will be displayed, as shown in Figure 8-34. Alternatively, select a node 
and right-click to display a shortcut menu. Next, select Add > Nodal Force from the 
shortcut menu displayed, refer to Figure 8-35; the Creating Nodal Force Object dialog 
box will be displayed.  

Note
To select a node of a model, click on the Selection tab in the Ribbon. Next, choose the Point 
or Rectangle tool from the Shape panel and the Vertices tool from the Select panel of the 
Selection tab in the Ribbon.
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Tip. If you invoke the Force tool to apply force while multiple nodes are selected, the name 
of the dialog box displayed will be Creating (number of nodes selected) Nodal Force 
Objects. 

Figure 8-34  The Creating Nodal Force Object dialog box

Figure 8-35  Choosing the Nodal Force option from the shortcut menu
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The options available in the Creating Nodal Force Object dialog box are discussed next. 

Magnitude Edit Box
The Magnitude edit box is used to specify the magnitude of the force to be applied 
on the selected object.   

Direction Area
The Direction area of the dialog box is used to specify the direction of force. You 
can specify the direction of force normal to the  X, Y, or Z direction by selecting the 
respective radio button from this area. For example, on selecting the X radio button, 
the direction of force will be toward the X direction with respect to the coordinate 
system displayed in the Coordinate System display area of the dialog box. The Global 
coordinate system is the default coordinate system. 

You can also specify the direction of force other than the X, Y, and Z directions by 
using the Custom radio button. To do so, select the Custom radio button; the X, Y, 
and Z edit boxes of the dialog box will be enabled. In these edit boxes, you can specify 
the coordinates of the force direction. 

Moreover, you can also specify the direction of force by specifying the direction 
vector. To do so, choose the Vector Selector button in the dialog box; the dialog 
box will disappear and you will be prompted to specify the direction vector for the 
force to be applied. Specify the start point and then the endpoint toward which the 
direction should point, refer to Figure 8-36. As soon as you specify the endpoint for 
the direction vector, the Creating Nodal Force Object dialog box will be displayed 
again with the coordinate value of the specifi ed direction vector entered in the X, Y, 
and Z edit boxes.

Figure 8-36  The direction vector for specifying the direction of force in a model

 Load Case/Load Curve Spinner
The Load Case/Load Curve spinner of the dialog box is used to select the required 
load case/load curve to associate with the force being applied. You will learn more 
about load case and load curve later in this chapter.
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Note
The Load Case/Load Curve spinner will be available only while applying nodal and edge 
forces in their respective dialog boxes. 

Also the Curve button, which is available on the right of the Load Case / Load Curve spinner 
in the dialog box, will be enabled only at the time of performing MES with nonlinear material 
analysis and the static stress with nonlinear material analysis. This button is used to defi ne the 
load curve to be followed by the force being applied. 

Description 
The Description area of the dialog box is used to enter a comment or description 
about the force being applied.

After specifying all the parameters for applying the nodal force, choose the OK button from 
the dialog box; the force will be applied on the selected node and an arrow representing the 
force will be displayed in the drawing area. 

Figure 8-37 shows a model with nodal force applied along the direction vector shown in 
Figure 8-36.

Figure 8-37  Arrow representing the applied nodal force

Note
You can select multiple nodes to apply force by using the CTRL key. However, in that case, the 
total magnitude of the force applied on the model will be equal to the number of nodes selected 
multiplied by the value of magnitude specifi ed. For example, if you select 4 nodes to apply 
force of 100 N, then the total magnitude of the force to be applied on the model will be 400 N 
(4 X 100).     

Applying  Edge Force 
The force applied on an edge is called edge force. To apply the edge force, select the 
edge of the model on which you want to apply the force and then choose the Force tool 
from the Loads panel of the Setup tab in the Ribbon; the Creating Edge Force Object 
dialog box will be displayed, as shown in Figure 8-38. Alternatively, select the edge and 
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right-click to display a shortcut menu. Next, select Add > Edge Force from the shortcut 
menu to invoke this dialog box. The options available in the Creating Edge Force Object 
dialog box are same as discussed earlier.

Note
To select an edge of a model, click on the Selection tab in the Ribbon. Next, choose the Point or 
Rectangle tool from the Shape panel and the Edges tool from the Select panel of the Selection 
tab in the Ribbon.

Applying  Surface Force 
The force applied on a surface is called surface force. To apply the surface force, select the 
surface of the model on which you want to apply the force and then choose the Force tool 
from the Loads panel of the Setup tab in the Ribbon; the Creating Surface Force Object 
dialog box will be displayed, as shown in Figure 8-39. Alternatively, select the surface and 
right-click to display a shortcut menu. Next, select Add > Surface Force from the shortcut 
menu to invoke this dialog box. 

Figure 8-38  The Creating Edge Force Object 
dialog box

Figure 8-39  The Creating Surface Force 
Object dialog box

The options available in the Creating Surface Force Object dialog box are same as in 
the Creating Nodal Force Object and Creating Edge Force Object dialog boxes except 
the Normal radio button. 
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Note
To select a surface of a model, click on the Selection tab in the Ribbon. Next, choose the Point 
or Rectangle tool from the Shape panel and the Surface tool from the Select panel of the 
Selection tab in the Ribbon.

On selecting the Normal radio button available in the Direction area of the Creating 
Surface Force Object dialog box, you can specify the direction of force normal to the 
selected surface. Note that after applying the force normal to a surface, the direction 
arrows representing the direction of force may not be displayed normal to the surface in 
the FEA Editor environment. However, in the Result environment, the arrows representing 
the direction of force will be displayed normal to the applied surface. 

Figure 8-40 shows the direction of arrows in the FEA Editor environment on applying 
the surface force normal to the curved surface of the model. Figure 8-41 shows the same 
model in Result environment with the direction of arrows normal to the curved surface.

Figure 8-40  Direction of arrows displayed in the 
FEA Editor environment on applying surface force 
normal to the curved surface of the model

Figure 8-41  Direction of arrows displayed in 
the Result environment on applying surface 
force normal to the curved surface of the model

Note
You will learn more about the Result environment of Autodesk Simulation Mechanical in later 
chapter.

Tip. You can select nodes, surfaces, or edges for applying force either before or after invoking 
the dialog box. 
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 Pressure
  Ribbon: Setup > Loads > Pressure 

Pressure is defi ned as the force per unit area. In Autodesk Simulation Mechanical, 
you can apply normal/traction pressure to the selected surface by using the options 
available in the Creating Surface Pressure/Traction Object dialog box. A normal 
pressure refers to the pressure that is applied normal to the selected surface whereas 
a traction pressure is applied in a specifi c direction. 

To apply normal/traction surface pressure, select the surface of the model on which you want 
to apply pressure and then choose the Pressure tool from the Loads panel of the Setup tab 
in the Ribbon; the Creating Surface Pressure/Traction Object dialog box will be displayed, 
as shown in Figure 8-42. Alternatively, select the surface and right-click to display a shortcut 
menu. Next, select Add > Surface Pressure/Traction from the shortcut menu to invoke this 
dialog box. 

Figure 8-42  The Creating Surface Pressure/Traction Object dialog box

The options available in the Creating Surface Pressure/Traction Object dialog box are 
discussed next.

Pressure Radio Button
The Pressure radio button of the dialog box is used to apply pressure normal to the 
selected surface. To apply the normal pressure, select the Pressure radio button and 
then enter the magnitude of the pressure in the Magnitude edit box available below this 
radio button.
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Traction Radio Button
The Traction radio button of the dialog box is used to apply a pressure that is oriented 
toward specifi c direction. To apply the traction pressure, select the Traction radio button; 
the X Magnitude, Y Magnitude, and Z Magnitude edit boxes will be enabled. In these edit 
boxes, you can specify the magnitude of the pressure in each of the global directions.  

Multiplier Edit Box 
The Multiplier edit box of the dialog box is used to enter the multiplier value for the load 
curve selected in the Load Curve fi eld of the dialog box. This edit box will be enabled 
while performing MES with nonlinear material analysis and static stress with nonlinear 
material analysis. 

 Load Curve Spinner 
The Load Curve spinner of the dialog box is used to set the load case to be used for the 
pressure being applied. After setting the load case to be used, you can modify the load 
curve of the respective load case by using the Curve button available next to the Load 
Curve spinner. On choosing the Curve button; the Multiplier Table Editor dialog box 
will be displayed, as shown in Figure 8-43.

Note
The Load Curve spinner and the Curve button of the Creating Surface Pressure/Traction 
Object dialog box will be enabled only while performing MES with nonlinear material analysis 
and the static stress with nonlinear material analysis.

Figure 8-43  The Multiplier Table Editor dialog box
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In the Multiplier Table Editor dialog box, the load curve is defi ned as the relationship 
between the time and multiplier. By default, two data points are defi ned for the load curve. 
You can defi ne multiple data points for the load curve. To do so, choose the Add Row 
button from the dialog box; a new row will be added to the left of the dialog box with the 
default time and multiplier values. Also, a new point will be added in the load curve with 
the default values. To specify new values for time and multiplier in a particular row, click 
on the fi eld corresponding to the Time (s) / Multiplier column of that row to activate 
its exit mode and then enter the required value in it. Next, press ENTER. If you want to 
delete a row, select the row to be deleted from the left side of the dialog box and then 
choose the Delete Row(s) button from the Multiplier Table Editor dialog box.  

You can import the data of an existing load curve which is saved in the .csv fi le format, 
using the Import CSV button of the dialog box. Similarly, you can export the current load 
curve data to a .csv fi le format, using the Export CSV button of the dialog box. You can 
also print the table containing the time and multiplier values of the data points by using 
the Print Table and Print Plot buttons in the dialog box. After specifying all the data 
points for defi ning the load curve, exit from the dialog box by choosing the OK button.

Description Area 
The Description area of the Creating Surface Pressure/Traction Object dialog box is 
used to enter a comment or description about the pressure being applied.

Figure 8-44 shows a mesh model with pressure applied on its all the inner surfaces. 
Figure 8-45 shows the same model after performing analysis with normal pressure applied 
and Figure 8-46 shows the model with traction pressure of same magnitude applied towards 
the Y axis direction.  

Figure 8-44  The pressure applied on the inner surfaces of the model
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Figure 8-45  Model after performing analysis with 
normal pressure applied on all its inner surfaces

Figure 8-46  Model after performing analysis with 
traction pressure applied in the direction of Y axis

 Variable Pressure
 Ribbon: Setup > Loads > Variable Pressure 

The variable pressure is applied by specifying different pressures at uniform 
intervals along the direction of the selected surface. To apply variable pressure 
to a surface, select the surface of the model on which you want to apply 

variable pressure. Next, choose the Variable Pressure tool from the expanded Loads panel 
of the Setup tab in the Ribbon, refer to Figure 8-47; the Creating Surface Variable Pressure 
Object dialog box will be displayed, as shown in Figure 8-48. 

Alternatively, select the surface and right-click to display a shortcut menu. Next, select Add > 
Surface Variable Pressure from the shortcut menu displayed to invoke the Creating Surface 
Variable Pressure Object dialog box. The options available in the Creating Surface Variable 
Pressure Object dialog box are discussed next. 

Figure 8-47  The Variable Pressure tool in the expanded 
Loads panel

 Coordinate system 
The Coordinate system drop-down list displays the list of all the coordinate systems defi ned 
in the current FEA Editor environment in addition to the global coordinate system. You 
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can select the required coordinate system from this drop-down list to be followed by the 
variable loads. Note that if you want the starting magnitude of the variable pressure to be 
zero and starts from the starting node of an edge of the surface then you need to create 
a coordinate system that has the origin at the starting node of the edge.

Figure 8-48  The Creating Surface Variable Pressure Object dialog box

Load orientation Area 
The options in the Load orientation area are used to specify the direction of pressure. 
On selecting the Normal to surface radio button, the direction of pressure being applied 
will be perpendicular to the surface selected for applying the pressure. On selecting the 
Traction radio button, the X, Y, and Z edit boxes on the right of this radio button will be 
enabled. By using these edit boxes, you can specify the direction vector for the variable 
pressure to be followed. 

Function defi nition Area 
The options in the Function defi nition area are used to specify a function that defi nes the 
variable load. The Active function drop-down list of this area displays the list of all the 
existing functions that are already specifi ed in the current session of Autodesk Simulation 
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Mechanical. From this drop-down list, you can select an existing function to be used for 
the variable load being applied. By default, the New Function option is selected in this 
drop-down list. You can also enter a new name in the edit fi eld of the Active function 
drop-down list to specify a new function for the variable load. 

The Expression fi eld in the Function defi nition area is used to specify the expression for 
the function selected in the Active function drop-down list. You can write the equation in 
the Expression fi eld for representing the pressure to be applied to the selected surface. 
You can use the variables r, s, and t in the expression, where r represents the distance in 
the X direction, s represents the distance in the Y direction, and t represents the distance 
in the Z direction. Also, you can use the basic operators such as +, -, * ,/, ( ,), and ̂  in the 
expression. For example, if 25*(r) is the expression entered in the Expression fi eld and 
the unit system is set to English (in), then the pressure at the distance of 50 inches along 
the X direction is equal to 1250 psi (25 x 50). In other words, as per the expression 25*(r), 
the pressure 25 psi is increasing per inch distance toward the X direction. If the 25*(r^2) 

will be the expression entered in the Expression fi eld, then the pressure at the distance 
of 50 inches along the X direction will be equal to 62500 psi [25 x (50x50)]. Similarly, 
250000 psi pressure at the distance of 100 inches along the X direction. 

You can also use some commonly used functions for defi ning the variable pressure. To do 
so, click on the Available Primitives button of the dialog box; a fl yout will be displayed. 
You can select the required functions from the fl yout displayed. 

To view the graphical representation of the variable pressure as per the expression entered 
in the Expression fi eld along a specifi c direction, choose the View button from the dialog 
box. As soon as you choose the View button, the Variable Load Viewer window will be 
displayed, refer to Figure 8-49.

Load case/load curve Spinner 
The Load case/load curve spinner is used to set the load case to be used for the pressure 
being applied. After setting the load case to be used, you can modify the load curve of the 
respective load case by using the Curve button available next to the Load Curve spinner. 
On choosing the Curve button; the Multiplier Table Editor dialog box will be displayed. 
The options in this dialog box area are same as discussed earlier.

Note
The Load case/load curve spinner and the Curve button of the Surface Variable Load Object 
dialog box will be enabled only in case of performing MES with nonlinear material analysis 
and the static stress with nonlinear material analysis.

Description Area 
The Description area of the dialog box is used to enter a comment or description about 
the pressure being applied.
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Figure 8-49  The Variable Load Viewer dialog box

Figure 8-50 shows the front view of a model in the Result environment with variable 
pressure that varies along the x axis by using the expression 25*(r^2).  Note that the 
origin of the coordinate system used for the variable pressure applied in the model shown 
in Figure 8-50 is at the starting node of the left side of the top edge. You will learn more 
about the Result environment in the later chapter.

Figure 8-50  Variable pressure applied on the top surface of the model
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 Hydrostatic Pressure
 Ribbon: Setup > Loads > Hydrostatic Pressure 

Hydrostatic pressure is the pressure that is exerted by a fl uid at equilibrium 
state. It varies linearly from the level of the fl uid in the direction of 
increasing depth of the fl uid. The magnitude of the hydrostatic pressure 

is directly proportional to the depth of the fl uid and to the density of the fl uid. 

To apply hydrostatic pressure, select the surface of the model. You can also select multiple 
surfaces by pressing the CTRL key. After selecting the surface, choose the Hydrostatic Pressure 
tool from the expanded Loads panel of the Setup tab in the Ribbon; the Creating Surface 
Hydrostatic Pressure Object dialog box will be displayed, refer to Figure 8-51. Alternatively, 
select the surface and right-click to display a shortcut menu. Next, select Add > Surface 
Hydrostatic Pressure from the shortcut menu displayed to invoke this dialog box. The options 
available in this dialog box are discussed next. 

Figure 8-51  The Creating Surface Hydrostatic Pressure Objects dialog box

Point on Fluid Surface (P) Area 
 The Point on Fluid Surface (P) area of this dialog box is used to specify the X, Y, and Z 

coordinates of the point that is on the top of the fl uid surface for creating the hydrostatic 
pressure. You can specify these coordinates in their respective X, Y, and Z edit boxes. Note 
that only the elements below this point will be affected by the magnitude of the pressure. 
The magnitude of the pressure on the elements of surfaces below this point will vary and 
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will depend upon the distance from the point on the fl uid surface and the density of fl uid. 
The distance from the point on the top of the fl uid surface will be multiplied by the value 
of the density of the fl uid to calculate the magnitude of pressure on an element.

 By using the Point Selector button in this area of the dialog box, you can also select a 
point directly from the drawing area as the top point on the fl uid surface. 

Fluid Depth Direction (V) Area 
 The Fluid Depth Direction (V) area of the dialog box is used to specify the direction 

vector for the depth of fl uid. You can specify the direction vector normal to the X, Y, or Z 
direction by selecting the respective radio button from this area. For example, on selecting 
the X radio button, the direction of fl uid depth will be toward the X direction with respect 
to the global coordinate system.  

 You can also specify the direction of fl uid depth other than the X, Y, and Z directions by 
using the Custom radio button. To do so, select the Custom radio button; the X, Y, and 
Z edit boxes of the dialog box will be enabled. In these edit boxes, you can specify the X, 
Y, and Z coordinates of the direction vector. 

 In addition to this, you can also specify the direction of fl uid depth by selecting two points 
in the drawing area. To do so, choose the Vector Selector button available on the right of 
the Custom radio button in the dialog box; the dialog box will disappear. Now, you can 
specify direction vector by selecting two points. Specify the start point and then the end 
points toward which the direction will point. As soon as you specify the endpoint for the 
direction vector, the dialog box will be displayed again with the coordinate values of the 
direction vector entered in the X, Y, and Z edit boxes.

Fluid Density Edit Box 
 The Fluid Density edit box is used to specify the density of the fl uid which will create the 

hydrostatic pressure. 

Pressure Type Drop-down List 
 The Pressure Type drop-down list is used to select the way the hydrostatic pressure will 

be applied on the selected surface. By default, the Normal to surface option is selected 
in this drop-down list. As a result, the direction of the magnitude applied will be normal 
to the selected surfaces.

 On selecting the Full pressure in horizontal option from this drop-down list, the magnitude 
of the hydrostatic pressure will be applied only in the horizontal direction. In other words, 
no pressure will be applied parallel to the direction vector of the fl uid depth.

 Figure 8-52 shows the representation of hydrostatic pressure applied on selecting the 
Normal to surface option from the Pressure Type drop-down list. Figure 8-53 shows the 
hydrostatic pressure applied horizontally by selecting the Full pressure in horizontal 
option.
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Figure 8-52  Hydrostatic pressure applied on surfaces 
with the Normal to surface option selected

Figure 8-53  Hydrostatic pressure applied on 
surfaces with the Full pressure in horizontal 
option selected

 If you select the Horizontal component only option from the Pressure Type drop-down 
list, the hydrostatic pressure will be applied horizontally only on the horizontal components 
of the selected surfaces. 

Note
 Note that if you select the Horizontal component only option, the magnitude of the hydrostatic 
pressure will be equal to the fl uid density multiplied by the depth of fl uid from the top surface 
and sin( ).

 Where  is the angle between the normal to the surface selected and the normal to the direction 
vector of the fl uid depth.

After specifying all the parameters for the hydrostatic pressure, choose the OK button from 
the dialog box.

 Remote Load & Constraint
 Ribbon: Setup > Loads > Remote Load & Constraint 

The Remote Load & Constraint tool is used to apply nodal load and 
boundary condition that originates from a point which is located in 
the space, not on the model. In other words, the load that originates 

from a point located in the space and is transmitted to the model through line elements such 
as beam, truss, or similar line elements is called as remote load. You can apply a remote load 
similar to applying force on the model, with the only difference that the location of the remote 
load origin can be anywhere in the space.

You can select vertices, lines, edges, surfaces, and parts for applying remote load. Regardless 
of the element selected, the remote load will be applied to the vertices of the selection. To 
apply remote load, choose the Remote Load & Constraint tool from the expanded Loads 
panel of the Setup tab in the Ribbon; the Create Remote Load dialog box will be displayed, 
as shown in Figure 8-54. The options in this dialog box are discussed next.
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Figure 8-54  The Create Remote Load dialog box

Attribute Area 
 The Part, Surface, and Layer spinners of the Attribute area are used to specify the part, 

surface, and layer attributes for the load elements. Make sure that the part number specifi ed 
in the Part spinner has not already been specifi ed to other part of the model.  

Load Location Area
 The Load Location area is used to specify the location from where the remote load will 

originate. You can specify the X, Y, and Z coordinates of the point in their respective X, 
Y, and Z edit boxes of the Load Location area. Note that this point will act as the point 
of originating remote load. Alternatively, you can select a vertex or construction vertex 
from the graphic area and choose the Use Selected Point button from the Load Location 
area of the dialog box; the coordinates of the selected point will be entered in the X, Y, 
and Z edit boxes of the dialog box.   
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Load Destination Area 
 The Load Destination area is used to specify the destination for the remote load. To 

specify the destination for the remote load, select the destination for it from the graphic 
area. The destination can be vertices, lines, edges, surfaces, or parts. Next, choose the 
Add button from the Load Destination area; the selected geometry will be selected as the 
destination for the remote load. Also, the name of the selected geometry will be displayed 
in the selection area of the Load Destination area of the dialog box. Similarly, by using 
the Add button, you can also add multiple geometries as destinations for the remote load. 
Note that all the vertices of the selections will be calculated for distributing the remote 
load. 

 You can also remove the selected geometry from the list of geometries added in the Load 
Destination area. To do so, select the geometry to be removed from the selection area of 
the Load Destination area and then choose the Remove button; the selected geometry 
will be removed.

Note
To select a vertex, line, edge, surface, or part, click on the Selection tab in the Ribbon. Next, 
choose the Point tool from the Shape panel and then the Vertices, Lines, Edges, Surfaces, or 
Parts tool from the Select panel of the Selection tab in the Ribbon.

Generate Load Elements Button 
 The Generate Load Elements button of the dialog box is used to generate the load 

elements that transmit the load from its originating location to the nodes of the model. 
As soon as you choose this button, a new geometry and a node at the specifi ed point in 
the space will be created. Also, the lines representing the load elements from the remote 
load location to the model will be displayed in the graphic area, refer to Figure 8-55. 

Note
The new geometry created on choosing the Generate Load Elements button will also be displayed 
in the Tree View. Therefore, you need to defi ne its element type, element defi nition, and the 
material to continue with the analysis process. 

Figure 8-55  The remote load applied on the model
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Add Load Button 
 The Add Load button of the dialog box is used to select the type of load or the boundary 

conditions to be applied at the remote load location. Note that this button will be enabled 
only after the load elements are generated. 

 To select the type of load or the boundary condition to be applied, click on the side arrow 
available on the Add Load button; a fl yout will be displayed, as shown in Figure 8-56. You 
can select the required type of remote load or the boundary conditions from this fl yout. 
Note that depending upon the type of remote load or boundary condition you select from 
the fl yout, the dialog box for specifying the parameters will be displayed.   

Figure 8-56  The fl yout displayed on clicking on the arrow on the Add Load button

After defi ning all the parameters for creating the remote load, exit from the Create Remote 
Load dialog box by choosing the Close button. The new part with the specifi ed part number 
will be displayed in the Tree View in red, refer to Figure 8-57. Also, the graphic representation 
of the line elements transforming the load from the point in space to the model, refer to the 
Figure 8-58.

Figure 8-57  The new part displayed in the Tree 
View in red

Figure 8-58  The graphical representation of the 
remote load applied on the model
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Now, you need to defi ne the element type, element defi nition, and the material for the newly  
created part in order to continue with the analysis process. 

Figure 8-59  A shortcut menu displayed 
with different element type options 

To defi ne the element type, select the Element Type 
sub-node under the newly created part node in the 
Tree View and right-click on it; a shortcut menu will be 
displayed with the options of different element types, 
refer to Figure 8-59. You can select the required element 
type from the shortcut menu displayed.

Note
If you have applied moment as the remote load, then 
you need to select the beam elements because the moment 
can be transmitted only through the beam elements. 
The other elements such as truss, gap, and so on do 
not have rotational degrees of freedom and cannot 
transmit moments and torques.

Similarly, you can defi ne the element defi nition and the material for the line elements that 
defi ne the remote load.

 Remote Force
 Ribbon: Setup > Loads > Remote Force  

The Remote Force tool is used to apply force that originates from a point 
which is located in the space, not on the model. You can apply remote force 
similar to applying a force on to the model with the only difference that the 

location of the remote force origin can be anywhere in the space.

You can select surfaces of the model for applying remote force. Note that regardless to the 
surface selected, the remote force will be distributed to all its nodes. To apply remote force, 
select the surface on which you want to simulate the effects of remote force and then choose 
the Remote Force tool from the Loads panel of the Setup tab in the Ribbon; the Creating 
Surface Remote Force dialog box will be displayed, as shown in Figure 8-60. The options in 
this dialog box are discussed next.

Magnitude Edit Box 
 The Magnitude edit box of the dialog box is used to specify the magnitude of the remote 

force.  

Remote Point Area
 The Remote Point area of the dialog box is used to specify the location from where the 

remote force will be applied. You can specify a point for originating remote force by 
specifying its X, Y, and Z coordinates in their respective X, Y, and Z edit boxes of the 
dialog box. 
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Figure 8-60  The Create Surface Remote Force dialog box

 Alternatively, you can select a vertex or a construction vertex from the graphic area and 
choose the Point Selector button from this area of the dialog box; the coordinates of the 
point will be displayed in the X, Y, and Z edit boxes of the dialog box. Also, the point 
will be selected as the point of origination of the remote force.   

Direction Area 
 The Direction area of the dialog box is used to specify the direction of force. You can 

specify the direction of force along the X, Y, or Z direction by selecting the respective 
radio button from this area. For example, on selecting the X radio button, the direction 
of force will be toward the X direction with respect to the Global Coordinate System. 

You can also specify the direction of force other than the X, Y, or Z directions by using 
the Custom radio button. To do so, select the Custom radio button; the X, Y, and Z edit 
boxes of the dialog box will be enabled. In these exit boxes, you can specify the X, Y, and 
Z coordinates of the force direction. 

In addition to this, you can also specify the direction of force by specifying two points in 
the graphic area. To do so, choose the Vector Selector button available in this area; the 
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dialog box will disappear and you will be prompted to specify the direction vector for 
the force to be applied. Specify the start point and then the endpoint for defi ning the 
direction. As soon as you specify the endpoint for the direction vector, the Create Surface 
Remote Force dialog box will be displayed again. Note that the coordinate values of the 
specifi ed direction vector are entered in the X, Y, and Z edit boxes.

Load Case/Load Curve Spinner
The Load Case/Load Curve spinner is used to select the required load case / load curve 
to be associated with the force being applied. 

Note
The Curve button which is available on the right of the Load Case/Load Curve spinner of 
the dialog box will be enabled only on performing MES with nonlinear material analysis and 
the static stress with nonlinear material analysis. This Curve button is used to defi ne the load 
curve to be followed by the force. 

Description 
The Description area of the dialog box is used to enter a comment or description about 
the force being applied.

After specifying all the parameters for applying the remote force, choose the OK button 
from the dialog box; the remote force will be applied on the selected surfaces and an arrow 
representing the direction of force will be displayed in the drawing area. 

Figure 8-61 shows a model with remote force applied on the circular face of the pulley.

Figure 8-61  Remote force applied on the model
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 Moment
 Ribbon: Setup > Loads > Moment 

A moment is a load or force that causes rotation of the nodes to which it is applied 
in a model. In Autodesk Simulation Mechanical, you can select nodes or surfaces 
for applying moment along a direction specifi ed by a vector. Note that the nodes 

connected with the nodes on which moment is applied will also be affected by the applied 
moment and tend to rotate about the specifi ed vector.  The procedure of applying nodal or 
surface moment is discussed next.

Applying  Nodal Moment 
 To apply nodal moment, select the node of the model and then choose the Moment tool 

from the Loads panel of the Setup tab in the Ribbon; the Creating Nodal Moment Object 
dialog box will be displayed, refer to Figure 8-62. You can also select multiple nodes for 
applying nodal moment by pressing the CTRL key. 

 Alternatively, you can also invoke this dialog box by selecting a node of the model and 
right clicking in the drawing area to display a shortcut menu. Next, select Add > Nodal 
Moments from the shortcut menu displayed.

Note
On selecting more than one node, the name of the dialog box invoked on choosing the Moment 
tool will be changed to Creating (number of nodes selected) Nodal Moment Objects.

You can select nodes for applying moment either before or after invoking the dialog box.

Figure 8-62  The Creating Nodal Moment Object dialog box
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 The options available in the dialog box are same as discussed earlier. Specify the parameters 
of the nodal moment such as magnitude, axis of rotation, and so on in their respective 
edit boxes. Note that the direction of rotation of moment can be controlled by specifying 
the positive or negative magnitude value. On specifying the positive magnitude value, 
the rotation of moment will be in the clockwise direction and on specifying the negative 
magnitude value, the rotation of moment will be in the counterclockwise direction. After 
specifying all the parameters, choose the OK button. Figure 8-63 shows a meshed model 
in FEA Editor environment with moment applied on a corner node of top right edge of 
the model. Figure 8-64 shows the same model in the Result environment with displacement 
representation that occurred due to the moment applied on the node. Note that the 
magnitude of the displacement is higher on the node where moment has been applied 
than the other nodes. In other words, the more the distance travelled by moment, the 
less will be its effect.     

Note
You can apply nodal moment only on plate and beam elements. Also, if you select multiple nodes to 
apply moment in a model, the magnitude of the moment will be applied to each selected node. For 
example, if you select 5 nodes and specify 10 as the magnitude of moment in the model units about 
the X axis, then the applied magnitude to the model will be 50 (5*10) in the model units. 

Figure 8-63  The nodal moment applied on a node 
of the top right edge of the model

Figure 8-64  Model in the Result environment after 
applying moment on a node of the model   

Applying  Surface Moment 
 Similar to applying nodal moment on the selected nodes you can also apply moment on 

surfaces. To do so, select the surface on which you want to apply moment and then choose 
the Moment tool from the Loads panel of the Setup tab in the Ribbon; the Creating 
Surface Moment Object dialog box will be displayed, refer to Figure 8-65. Alternatively, 
you can invoke this dialog box by selecting the surface of the model and right-click in the 
drawing area to display a shortcut menu. Next, select Add > Surface Moment from the 
shortcut menu displayed.
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Figure 8-65  The Creating Surface Moment Object dialog box

 The options available in the dialog box are same as discussed earlier. Specify the parameters 
of the surface moment, such as magnitude, axis of rotation, and so on in their respective 
edit boxes. Next, choose the OK button. Figure 8-66 shows a meshed model in the FEA 
Editor environment with the moment applied on its front face and Figure 8-67 shows the 
model in the Result environment. You will learn more about the Result environment of 
Autodesk Simulation Mechanical in the later chapters.

Figure 8-66  Moment applied on the front 
surface of the model

Figure 8-67  The model in the Result 
environment 
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Note
You can apply surface moment only on plate, brick, and tetrahedron elements. 

 Bearing Load
 Ribbon: Setup > Loads > Bearing        

A bearing load is defi ned as a compressive load that causes radial, thrust, or 
combination of radial and thrust loading between the contact areas of shafts and 
bearing or bushings. To apply the bearing load: radial and thrust, select a cylindrical 

surface of the model where you want to apply bearing load from the drawing area and then 
choose the Bearing tool from the Loads panel of the Setup tab in the Ribbon; the Creating 
Bearing Load Object dialog box will be displayed, refer to Figure 8-68. In this dialog box, 
you can specify the parameters for applying thrust and radial loading. The left half of the 
dialog box displays the options for specifying the thrust load and right half of the dialog box 
displays the options for specifying the radial load. 

Note
You can also select multiple cylindrical surfaces for applying the bearing load by pressing the 
CTRL key. However, depending upon the number of surfaces selected, name of the dialog box 
invoked will be modifi ed and will display count number. For example, on selecting one surface, 
the name of the dialog box invoked will be displayed as Creating 1 Bearing Load Object, 
refer to Figure 8-66. On the other hand, on selecting two surfaces, the name of the dialog box 
invoked will be displayed as Creating 2 Bearing Load Objects. 

Figure 8-68  The Creating Bearing Load Object dialog box
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To apply the thrust/radial load on the selected surface, specify the magnitude of thrust/radial 
load in their respective Magnitude edit boxes. The Magnitude edit box available at the left 
in the dialog box is used to specify the magnitude of the thrust load whereas, the Magnitude 
edit box at the right in the dialog box is used to specify the magnitude of the radial load. Note 
that in case of thrust load, the direction vector of the load being applied will automatically be 
selected in the axial direction of the surfaces selected. Therefore, the X, Y, and Z edit boxes 
available in the left side in the dialog box for specifying the direction vector for the thrust 
load will not be enabled. However, you can reverse the default direction of the thrust direction 
vector by choosing the Toogle Vector Direction button. 

To specify the direction vector for the radial load, select the X, Y, or Z radio button. You can 
also choose the Custom radio button to specify the radial direction vector other than the global 
X, Y, and Z directions by entering the value of x, y, and z vectors manually in their respective 
edit boxes. These edit boxes will be enabled on choosing the Custom radio button. Note that 
the radial direction vector should not be parallel to the thrust direction vector.

You can also specify the load case/load curve to be followed for the bearing load (thrust/radial 
load) being applied by using the Load Case/Load Curve spinner of the dialog box. After 
specifying all the parameters for applying the bearing load (thrust/radial load), choose the 
OK button; the bearing load will be applied to the selected cylindrical surface.

Figure 8-69 shows the thrust load applied on one half of the cylindrical surface in the FEA Editor 
environment and Figure 8-70 shows the same model in the Result environment after performing 
the analysis. You will learn more about Result environment in the later chapters.      

Figure 8-69   Thrust load applied on a surface 
of the model in the FEA Editor environment

Figure 8-70  The model in the Result environment 
after applying the thrust load 

Figure 8-71 shows the radial load applied on one half of the cylindrical surface in the FEA 
Editor environment and Figure 8-72 shows the same model in the Result environment after 
performing the analysis.    
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Figure 8-71  Radial load applied on a surface 
of the model in FEA Editor environment

Figure 8-72  The model in the Result environment 
after applying the radial load 

 Gravity
 Ribbon: Setup > Loads > Gravity     

Gravity is defi ned as a force per unit mass. It applies constant acceleration along the 
direction to a part that has mass. In Autodesk Simulation Mechanical, you can simulate 
the force of gravity by defi ning the acceleration occurred due to the body force. To 
defi ne gravity or acceleration load for a model, choose the Gravity tool from the 
Loads panel of the Setup tab in the Ribbon; the Analysis Parameters dialog box will 

be displayed with Gravity/Acceleration tab chosen, refer to Figure 8-73.   

Figure 8-73  The Analysis Parameters dialog box with the Gravity/Acceleration tab chosen
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To specify the standard acceleration due to gravity on earth, choose the Set for standard gravity 
button from the Gravity/Acceleration tab. As soon as you choose this button, the standard 
acceleration due to the gravity on earth as per the units defi ned for the model will be entered 
automatically in the Acceleration due to body force edit box of the Gravity/Acceleration tab 
in the dialog box. You can also enter a different acceleration magnitude as per the requirement 
in the Acceleration due to body force edit box.

After specifying the acceleration, you need to defi ne the direction along which the acceleration 
will be applied. The X multiplier, Y multiplier, and Z multiplier edit boxes of the Gravity/
Acceleration tab in the dialog box are used to defi ne the vector along which the acceleration 
will be applied. To specify the direction of acceleration towards the positive direction of X 
axis, specify a positive value in the X multiplier edit box of the dialog box. To specify the 
direction of acceleration towards the negative direction of X axis, specify a negative value 
in the X multiplier edit box. Similarly, you can specify the direction of acceleration towards 
the positive or negative direction of Y and Z axes. In addition to specifying the acceleration 
direction along the X, Y, or Z axes, you can also specify the acceleration along an arbitrary 
direction by specifying the value in more than one edit box. For example, if you enter 1 in 
the X multiplier and 1 in the Y multiplier, the direction of acceleration will bisecting the X 
and Y axes.     

Note
The value entered in the Acceleration due to body force edit box will be multiplied by the values 
entered in the X multiplier, Y multiplier, and Z multiplier edit boxes before it is applied to 
the model in the direction of acceleration of gravity. 

The Reset From Default button of the dialog box is used to reset the values to default.

After defi ning the gravity and its direction, choose the OK button from the dialog box; the 
gravity will be applied and the direction arrow will be displayed in the model.  

Figure 8-74  A meshed model with direction 
arrow of the gravity applied 

Note
You may need to change the display style of the 
model to view the direction arrow of the applied 
gravity to either Mesh or Edges display style. To do 
so, click on the View tab in the Ribbon and then 
choose the Mesh or Edges option from the Visual 
Style drop-down list in the Appearance panel of 
the View tab.  

Figure 8-74 shows a model with an arrow pointing in 
the downward direction, representing the acceleration 
direction of the gravity applied.  
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TUTORIALS
Tutorial 1

In this tutorial, you will open the meshed model of Tutorial 1 of Chapter 5, refer to Figure 8-75. 
You will then assign Stainless Steel (AISI 405) material to the model. After assigning the 
material, you will apply the boundary conditions such as force, pin constraint, and frictionless 
constraint to the model, refer to the Figure 8-76. While applying the Pin constraint, you need 
to fi x the radial and axial movement.
           (Expected time: 30 min)

Figure 8-75  The meshed model for Tutorial 1

Figure 8-76  Required boundary conditions of the model
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 The following steps are required to complete this tutorial:

a. Start Autodesk Simulation Mechanical. 
b. Open Tutorial 1 of Chapter 5 in Autodesk Simulation Mechanical.
c. Save the Tutorial 1 of Chapter 5 model in the c08 folder with the name c08_tut01.
d. Assign material to the model.
e. Apply pin Constraint.
f. Apply frictionless Constraint.
g. Apply force.
h. Save and close the model.

Opening Tutorial 1 of Chapter 5
 As the required input fi le is saved in the c05 folder, you need to browse to this folder and 

then open the c05_tut01.fem fi le in Autodesk Simulation Mechanical.

1. Start Autodesk Simulation Mechanical and then choose the Open button from the Quick 
Access Toolbar; the Open dialog box is displayed.

2. Browse to the C:\Autodesk Simulation Mechanical\c05\Tut01 folder.  

3. Select the c05_tut01.fem fi le and then choose the Open button from the dialog box; the 
selected fem fi le is opened in the Autodesk Simulation Mechanical.  

Saving the .fem File in the c08 Folder
When you open a fi le created in some other chapter, it is recommended to fi rst save the fi le 
with a different name in the folder of the current chapter (document), before modifying 
it. On saving the fi le in the current chapter folder, the original fi le of the other chapter 
will not get modifi ed.

1. Choose the Save As button from the Application Menu; the Save As dialog box is 
displayed.

2. Browse to the \Autodesk Simulation Mechanical folder. Next, create a new folder with the name 
c08 by using the New Folder button. Create one more folder with the name Tut01 inside 
the c08 folder. Make the newly created Tut01 folder the current folder by double-clicking 
on it.

3. Enter c08_tut01 as the new name of the fi le in the File name edit box and then choose 
the Save button to save the fi le.

 The fi le is saved with the new name and is now opened in the graphic area of Autodesk 
Simulation Mechanical.
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Assigning Material
 Now, you need to assign material to the model.

1. Expand the Part node by clicking on the + sign available on its left in the Tree View.  
Next, right-click on the Material <Unnamed> option available under the Part node in 
the Tree View and then select the Edit Material option from the shortcut menu displayed; 
the Element Material Selection dialog box will be displayed, refer to Figure 8-77.

Figure 8-77  The Element Material Selection dialog box

2. Make sure Autodesk Simulation Material Library is selected in the Select Library 
drop-down list of the dialog box. Next, expand the Steel material family node by clicking 
on the + sign available on the left of the Steel node.

3. Expand the Stainless sub-node from the Steel material family and then select the Stainless 
Steel (AISI 405) material; all the default properties of the Stainless Steel (AISI 405) 
material are displayed on the right in the dialog box, as shown in Figure 8-78.

4. Choose the OK button from the dialog box; all the properties of the selected material are 
assigned to the model.
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Figure 8-78  The Element Material Selection dialog box with the Stainless Steel (AISI 
405) material selected 

Applying Pin Constraint
 Now, you need to apply the pin constraint to the inner cylindrical surface of the model, 

refer to Figure 8-76.

1. Change the current orientation of the model similar to the one shown in Figure 8-79 by 
using the ViewCube.

Figure 8-79  Changed orientation of the model
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2. Click on the Selection tab of the Ribbon and then choose the Circle tool from the Shape 
panel of the Selection tab. Next, choose the Surfaces tool from the Select panel from the 
Selection tab in the Ribbon.

3. Draw a circle around the large hole of the model, refer to Figure 8-80. All the surfaces 
that are completely enclosed inside the circle are selected, refer to Figure 8-81.

Figure 8-80  The circle being drawn around the 
large hole of the model

Figure  8-81  Surfaces that are completely enclosed 
inside the circle drawn are selected

4. Choose the Setup tab of the Ribbon and then choose the Pin Constraint tool 
from the Constraints panel of the Setup tab in the Ribbon; the Creating Pin 
Constraint Objects dialog box is displayed, as shown in Figure 8-82.

5. Select the Fix Radial and Fix Axial check boxes from the Constraints area of the dialog 
box. Next, choose the OK button; the pin constraint is applied. Figure 8-83 shows the 
rotated view of the model with the pin constraint applied.

Figure 8-82  The Creating Pin Constraint 
Objects dialog box

Figure  8-83  The rotated view of the model with 
pin constraint applied
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Applying Frictionless Constraint
 Now you need to apply frictionless constraint to one half of the larger outer cylindrical 

surface of the model, refer Figure 8-76.

1. Change the current orientation of the model similar to the one shown in Figure 8-84 by 
using the ViewCube.

2. Click on the Selection tab of the Ribbon and then choose the Point or rectangle tool 
from the Shape panel of the Selection tab. Next, choose the Surfaces tool from the Select 
panel of the Selection tab in the Ribbon.

3. Select the bottom surface of the outer cylinder by clicking the left mouse button, refer to 
Figure 8-85. 

Figure 8-84  Rotated view of the model Figure  8-85  Surface selected for applying the 
frictionless constraint

4. Choose the Setup tab of the Ribbon. Next, expand the Constraints panel of the Setup tab 
in the Ribbon by clicking on the down arrow available on the Constraints panel bar.

5. Choose the Frictionless tool from the expanded Constraints panel, refer to Figure 8-86; 
the Creating Frictionless Constraint Object dialog box is displayed, as shown in 
Figure 8-87.

Figure 8-86  The expanded Constraints 
panel of the Setup tab 

Figure 8-87  The Creating Frictionless 
Constraint Object dialog box 
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6. Choose the OK button from the Creating Frictionless Constraint Object dialog box; 
the frictionless constraint is applied to the selected surface of the model, refer to 
Figure 8-88.

Figure 8-88  The frictionless constraint applied on the surface

Note
In Figure 8-88, the visual style of the model has been changed to edges visual style for clarity. 
You can do so choosing the Edges tool from the Visual Style drop-down of the Appearance 
panel of the View tab in the Ribbon. 

Applying Force
 Now you need to apply force of 500 N on the top planar surface of the model, refer to 

Figure 8-76.

1. Select the top planar surface of the model for applying the force of 500 N by clicking the 
left mouse button, refer to Figure 8-89.

2. Choose the Setup tab of the Ribbon and then choose the Force tool from the Loads 
panel; the Creating Surface Force Object dialog box is displayed.

3. Enter 500 in the Magnitude edit box of the dialog box. Next, make sure that the Normal 
radio button is selected in the Direction area of the dialog box.

4. Choose the OK button from the dialog box; the force of magnitude 500 N is applied to 
the selected surface and the arrows representing the force are displayed in the graphic 
area, as shown in Figure 8-90.
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Figure 8-89  Surface selected for applying force Figure  8-90  The arrows representation of force 
applied

Saving the Model
1. Choose the Save button from the Quick Access Toolbar to save the model. 

2. Choose Close from the Application Menu to close the fi le.   

Tutorial 2
In this tutorial, you will open model that was meshed in Tutorial 1 of Chapter 7, refer to 
Figure 8-91. You will then assign Aluminum Alloy 6061-O material to all the parts of the 
model. After assigning the material, defi ne the cross-section area for the truss element used 
in pin joint part of the model to 2 square millimeter. Next, apply the boundary conditions 
such as force of magnitude 500 N and 1D spring constraint with stiffness value 1000 N/mm, 
refer to Figure 8-92.           (Expected time: 30 min)

Figure 8-91  The model for Tutorial 2
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Figure 8-92  Required boundary conditions of the model

 The following steps are required to complete this tutorial:

a. Start Autodesk Simulation Mechanical. 
b. Open Tutorial 1 of Chapter 7 in Autodesk Simulation Mechanical.
c. Save the opened model in the c08 folder with the name c08_tut02.
d. Assign material to the model.
e. Defi ne cross-section for truss element in pin joint.
f. Apply 1D spring support constraint.
g. Apply fi xed constraint.
h. Apply force.
i. Save and close the model.

Opening Tutorial 1 of Chapter 7
 As the required input fi le is saved in the c07 folder, you need to browse to this folder and 

then open the c07_tut01.fem fi le in Autodesk Simulation Mechanical.

1. Start Autodesk Simulation Mechanical, if not started already. Next, choose the Open 
button from the Quick Access Toolbar; the Open dialog box is displayed.

2. Browse to the C:\Autodesk Simulation Mechanical\c07\Tut01 folder.  

3. Select the c07_tut01.fem fi le and then choose the Open button from the dialog box; the 
selected fem fi le is opened in the Autodesk Simulation Mechanical.  

Saving the .fem File in the c08 Folder
When you open a fi le created in some other chapter, it is recommended that you fi rst 
save the fi le with a different name in the folder of the current chapter (document), before 
modifying it. This is because if you save the fi le in the folder of the current chapter, the 
original fi le will not get modifi ed.

1. Choose the Save As button from the Application Menu; the Save As dialog box is 
displayed.
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2. Browse to the Autodesk Simulation Mechanical folder. Next, create a new folder with the 
name c08 by using the New Folder button, if not created in Tutorial 1 of this chapter. 
Next, create a folder with the name Tut02 inside the c08 folder. Make the newly created 
Tut02 folder the current folder by double-clicking on it.

3. Enter c08_tut02 as the new name of the fi le in the File name edit box and then choose 
the Save button to save the fi le.

 The fi le is saved with the new name and is now opened in the graphic area of Autodesk 
Simulation Mechanical.

Assigning Material
 Now, you need to assign material to all the parts of the model.

1. Expand the Part 1 and Part 2 nodes in the Tree View and then select the Material 
<Unnamed> options of both the parts (Part 1 and Part 2) by pressing the CTRL key.

2. Right-click to display a shortcut menu and select the Edit Material option from the shortcut 
menu displayed; the Element Material Selection dialog box is displayed.

3. Expand the Aluminum material family node by clicking on the + sign available on the 
left of the Aluminum node; the materials available in this family are displayed.

4. Select the Aluminum Alloy 6061-O material from the list of Aluminum material family; 
all the properties of the selected material are displayed on the right side of the dialog 
box.

5. Choose the OK button from the dialog box; all the properties of the Aluminum Alloy 
6061-O material are assigned to the selected parts of the model.

6. Similarly, assign the Aluminum Alloy 6061-O material to the Part 3 of the model.

Defi ning Cross-section for Truss Element in Pin Joint
 Now, you need to defi ne cross-section for the truss elements used from creating the pin 

joint in the model.

1. Expand the Part 3 nodes in the Tree View, if not expanded already. Next, select the 
Element Defi nition option and right-click to display a shortcut menu.

2. Select the Edit Element Definition option from the shortcut menu; the Element 
Defi nition - Truss dialog box is displayed, as shown in Figure 8-93.

3. Enter 2 in the Cross-sectional area edit box of the dialog box. Next, choose OK; the 
cross-section of 2 square millimeter is defi ned for the truss elements.  
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Figure 8-93  The Element Defi nition - Truss dialog box

Applying 1D Spring Support Constraint
 Now, you will apply 1D spring support constraint.

1. Change the current orientation of the model similar to the one shown in Figure 8-94 by 
using the ViewCube.

2. Click on the Selection tab of the Ribbon and then choose the Point or Rectangle tool 
from the Shape panel of the Selection tab. Next, choose the Surfaces tool from the Select 
panel from the Selection tab in the Ribbon.

3. Select the curved surface by clicking the left mouse button, refer to Figure 8-95. 

Figure 8-94  Changed orientation of the model Figure  8-95  Surface selected for applying the 
1D spring support constraint

4. Choose the 1D Spring Support tool from the Constraints panel of the 
Setup tab in the Ribbon; the Creating Surface 1D Spring Support 
Element dialog box is displayed, as shown in Figure 8-96.

5. Make sure that the Translation radio button is selected in the Type area and the Custom 
radio button is selected in the Direction area of the dialog box, refer to Figure 8-96.

6. Enter 1 in both the X and Y edit boxes of the Direction area in the dialog box.



8-66              Autodesk Simulation Mechanical for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 8-96  The Creating Surface 1D Spring Support Element dialog box

7. Enter 1000 in the Stiffness edit box of the dialog box. Next, choose the OK button; the 
1D spring support is applied to the selected surface of the model, refer to Figure 8-97.

Applying Fixed Constraint
 Now, you need to apply fixed constraint to the surface of the model, refer to 

Figure 8-92.

1. Select the surface of the model for applying the fi xed constraint, refer to Figure 8-98.

Figure 8-97  The 1D spring support applied to the 
selected surface of the model 

Figure  8-98  Surface selected for applying the 
fi xed constraint
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2. Select the General Constraint tool from the Constraints panel of the Setup tab 
in the Ribbon; the Creating Surface General Constraint Object dialog box is 
displayed, as shown in Figure 8-99.

Figure 8-99  The Creating Surface General Constraint Object dialog box

3. Choose the Fixed button from the Predefi ned area of the dialog box; all the check boxes 
available in the Constrained DOFs area of the dialog box are selected.

4. Choose the OK button; the fi xed constraint is applied to the selected surface.

Applying Force
 Now, you need to apply force of 500 N on the top planar surface of the model, refer to 

Figure 8-92.

1. Select the top planar surfaces of the model for applying the force of 500 N by pressing 
the CTRL key, refer to Figure 8-100.

2. Choose the Force tool from the Loads panel of the Setup tab in the Ribbon; the 
Creating Surface Force Objects dialog box is displayed.

3. Enter 500 in the Magnitude edit box of the dialog box. Next, make sure that the Normal 
radio button is selected in the Direction area of the dialog box.

4. Choose the OK button from the dialog box; the force of magnitude 500 N is applied to 
the selected surfaces and the arrows representing the force are displayed in the graphic 
area, as shown in Figure 8-101.
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Saving the Model
1. Choose the Save button from the Quick Access Toolbar to save the model. 

2. Choose Close from the Application Menu to close the fi le.

Figure 8-100  Surfaces selected for applying force Figure  8-101  The arrows representation of force 
applied

 Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1. In Autodesk Simulation Mechanical, the default properties of a material cannot be 
modifi ed. (T/F)

2. In Autodesk Simulation Mechanical, the material library fi le is saved in the .mlb fi le format. 
(T/F)

3. You can create a copy of an existing material library to create a new material library. 
(T/F)

4. The General Constraint tool is used to constraint the degree of freedom of nodes. 
(T/F)

5. In Autodesk Simulation Mechanical, by default, you are only provided with Autodesk 
Simulation Material Library. (T/F)

6. The general constraint applied on a node is called __________.

7. The __________ tool is used to constraint the radial, tangential, and axial degree of 
freedom of the selected cylindrical surface.
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8. On choosing the Remote Loads tool, the __________ dialog box will be displayed.

9. In Autodesk Simulation Mechanical, you can apply __________ or __________ pressure 
to the selected surface by using the Creating Surface Pressure/Traction Object dialog 
box. 

10. On choosing the __________ button from the Predefi ned area of the Creating Nodal 
General Constraint Object dialog box, the translation degree of freedom along the X, Y, 
and Z axes of the selected node will be constrained.

 Review Questions 
Answer the following questions:

1. In Autodesk Simulation Mechanical, in addition to the default libraries, you can create a 
new material library. (T/F)

2. In Autodesk Simulation Mechanical, you cannot delete a material from the user-defi ned 
material libraries. (T/F)

3. You can apply pin constraint to the cylindrical and planar surfaces of the model. (T/F)

4. Which of the following dialog boxes is displayed on choosing the Variable Pressure 
tool?

  (a) Variable Pressure   (b) Creating Variable Pressure
  (c) Creating Surface Variable Pressure (d) None of these

5. Which of the following dialog boxes is displayed on choosing the Gravity tool?

  (a) Analysis Gravity    (b) Analysis Parameters
  (c) Gravity    (d) None of these

6. Which of the following dialog boxes is displayed on choosing the Edit Properties button 
from the Element Material Selection dialog box?

  (a) Element Material Specifi cation (b) Edit Specifi cation
  (c) Edit Material Specifi cation  (d) None of these

7. Which of the following radio buttons of the Creating Surface Pressure/Traction Object 
dialog box is used to apply a pressure that is oriented in a specifi c directions?

  (a) Pressure     (b) Traction
  (c) Pressure/Traction   (d) None of these
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8. On choosing the __________ button from the Creating Surface Pressure/Traction Object 
dialog box, the Multiplier Table Editor dialog box will be displayed.

9. On choosing the Import CSV button from the Multiplier Table Editor dialog box, you 
can import the data of an existing load curve is saved in the __________ fi le format.

EXERCISES
Exercise 1

In this exercise, you will open the model created in Tutorial 3 of Chapter 7, refer to Figure 8-102. 
You will then assign Stainless Steel (AISI 202) material to all parts of the model. After assigning 
the material, apply the boundary conditions such as pressure of magnitude 1000 N inside the 
model and the fi xed constraint at the base end of the model, refer to Figure 8-103. 
           (Expected time: 30 min)

Figure 8-102  The model for Exercise 1 Figure 8-103  The model after applying 
boundary conditions
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Exercise 2
In this exercise, you will open the model created in Tutorial 2 of Chapter 7, refer to Figure 8-104. 
You will then assign Stainless Steel (AISI 446) material to all parts of the model. After assigning 
the material, defi ne the cross-section area for the truss elements used in pin joint parts of the 
model to 1 square millimeter. Next, apply the boundary conditions such as force of magnitude 
650 N at the top planar face of the model towards down and fi xed constraint at the base of 
the model, refer to Figure 8-105.  
           (Expected time: 30 min)

Figure 8-104  The model for Exercise 2 Figure 8-105  The model after applying 
boundary conditions
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Answers to Self-Evaluation Test
1. F, 2. T, 3. T, 4. T, 5. F, 6. nodal general constraint, 7. Pin Constraint, 8. Creating Surface 
Remote Force, 9. pressure and traction, 10. No Translation


